
Preface

Web Development and Design Foundations with HTML5 is intended for use in a begin-

ning web development course. This textbook introduces HTML and CSS topics such as 

text configuration, color configuration, and page layout, with an enhanced focus on the 

topics of design, accessibility, and Web standards. The text covers the basics that web 

developers need to build a foundation of skills:

• Internet concepts

• Creating web pages with HTML5

• Configuring text, color, and page layout with Cascading Style Sheets (CSS)

• Web design best practices

• Accessibility standards

• The web development process

• Using media and interactivity on web pages

• New CSS3 properties

• Website promotion and search engine optimization

• E-commerce and the Web

• JavaScript

A special feature of this text is the Web Developer’s Handbook, which is a collection of 

appendixes that provide resources such as an HTML5 Reference, Comparison of XHTML 

and HTML5, Special Entity Character List, CSS Property Reference, WCAG 2.0 Quick 

Reference, FTP Tutorial, and web-safe color palette.

New to This Edition

Building on this textbook’s successful eighth edition, new features for the ninth edition 

include the following:

• Updated coverage of HTML5 elements and attributes

• Expanded coverage of designing for mobile devices

• Updates for HTML5.1 elements and attributes

• Expanded coverage of responsive web design techniques and CSS media queries

• Updated code samples, case studies, and web resources

• An introduction to CSS Grid Layout

• Updated reference sections for HTML5 and CSS

• Additional Hands-On Practice exercises
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Student files are available for download from the companion website for this textbook at 

www.pearson.com/cs-resources. These files include solutions to the Hands-On Practice 

exercises, the Website Case Study starter files, and access to the book’s companion 

VideoNotes. See the access card in the front of this textbook for further instructions.

Design for Today and Tomorrow

This textbook has a modern approach that prepares students to design web pages that 

work today, in addition to being ready to take advantage of the new HTML5 and CSS 

coding techniques of the future.

Organization of the Text

This textbook is designed to be used in a flexible manner; it can easily be adapted to suit 

a variety of course and student needs. Chapter 1 provides introductory material, which 

may be skipped or covered, depending on the background of the students. Chapters 2 

through 4 introduce HTML and CSS coding. Chapter 5 discusses web design best 

practices and can be covered anytime after Chapter 3 (or even along with Chapter 3). 

Chapters 6 through 9 continue with HTML and CSS.

Any of the following chapters may be skipped or assigned as independent study, 

depending on time constraints and student needs: Chapter 7 (More on Links, Layout, and 

Mobile), Chapter 10 (Web Development), Chapter 11 (Web Multimedia and Interactivity), 

Chapter 12 (E-Commerce Overview), Chapter 13 (Web Promotion), and Chapter 14 

(A Brief Look at JavaScript and jQuery). A chapter dependency chart is shown in Figure P.1.

Figure P.1 This textbook is 

flexible and can be adapted to 

individual needs
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Brief Overview of Each Chapter 

Chapter 1: Introduction to the Internet and World Wide Web This 

brief introduction covers the terms and concepts related to the Internet and the Web 

with which Web developers need to be familiar. For many students, some of this will be a 

review. Chapter 1 provides the base of knowledge on which the rest of the textbook is built.

Chapter 2: HTML Basics As HTML5 is introduced, examples and exercises 

encourage students to create sample pages and gain useful experience. Solution pages for 

the Hands-On Practice are available in the student files.

Chapter 3: Configuring Color and Text with CSS The technique of using 

Cascading Style Sheets to configure the color and text on web pages is introduced. Stu-

dents are encouraged to create sample pages as they read through the text. Solutions for 

the Hands-On Practice are available in the student files.

Chapter 4: Visual Elements and Graphics This chapter discusses the use of 

graphics and visual effects on web pages, including image optimization, CSS borders, CSS 

image backgrounds, new CSS3 visual effects, and new HTML5 elements. Students are 

encouraged to create web pages as they read through the text. Sample solutions for the 

Hands-On Practice are available in the student files.

Chapter 5: Web Design This chapter focuses on recommended web design prac-

tices and accessibility. Some of this is reinforcement because tips about recommended 

website design practices are incorporated into the other chapters.

Chapter 6: Page Layout This chapter continues the study of CSS begun earlier 

and introduces techniques for positioning and floating web page elements, including a 

two-column CSS page layout. New HTML5 semantic elements and techniques to provide 

HTML5 compatibility for older browsers are also introduced. Sample solutions for the 

Hands-On Practice are available in the student files.

Chapter 7: More on Links, Layout, and Mobile This chapter revisits earlier 

topics and introduces more advanced techniques related to hyperlinks, using CSS sprites, 

a three-column page layout, configuring CSS for print, designing pages for the mobile 

web, responsive web design with CSS media queries, responsive images, the new Flexible 

Box Layout Module, and the new CSS Grid Layout Module. Students are encouraged to 

 create pages as they read through the text. Sample solutions for the Hands-On Practice are 

 available in the student files.

Chapter 8: Tables This chapter focuses on the HTML elements used to create 

tables. Methods for configuring a table with CSS are introduced. Students are encouraged 

to create pages as they read through the text. Sample solutions for the Hands-On Practice 

are available in the student files.

Chapter 9: Forms This chapter focuses on the HTML elements used to create 

forms. Methods for configuring the form with CSS are introduced. New HTML5 form 

 control elements and attribute values are introduced. Students are encouraged to create 

sample pages as they read through the text. Sample solutions for the Hands-On Practice 

are available in the student files.
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Chapter 10: Web Development This chapter focuses on the process of website 

development, including the job roles needed for a large-scale project, the web develop-

ment process, and web hosting. A web host checklist is included in this chapter.

Chapter 11: Web Multimedia and Interactivity This chapter offers an over-

view of topics related to adding media and interactivity to web pages. These topics include 

HTML5 video and audio, Flash®, Java™ applets, CSS3 transform and transition  properties, 

interactive CSS menu, interactive image gallery, JavaScript, jQuery, Ajax, and HTML5 APIs. 

Students are encouraged to create pages as the topics are discussed. Sample solutions for 

the Hands-On Practice are available in the student files.

Chapter 12: E-Commerce Overview This chapter introduces e-commerce, 

security, and order processing on the Web.

Chapter 13: Web Promotion This chapter discusses site promotion from the web 

developer’s point of view and introduces search engine optimization.

Chapter 14: A Brief Look at JavaScript and jQuery This chapter provides 

an introduction to client-side scripting using JavaScript and jQuery. Sample solutions for 

the Hands-On Practice are available in the student files.

Web Developer’s Handbook Appendixes: This handbook contains appen-

dixes that include resources and tutorials that are useful for students, such as an HTML5 

Quick Reference, Special Entity Characters, a Comparison of XHTML and HTML5, a CSS 

 Property Reference, a WCAG 2.0 Quick Reference, an FTP Tutorial, and a web-safe color 

palette.

Features of the Text 

Well-Rounded Selection of Topics This text includes both “hard” skills such 

as HTML5, CSS, and JavaScript (Chapters 2, 3, 4, 6, 7, 8, 9, and 14) and “soft” skills 

such as web design (Chapter 5), website promotion (Chapter 13), and e-commerce 

( Chapter 12). This well-rounded foundation will help students as they pursue careers as 

web professionals. Students and instructors will find classes more interesting because they 

can discuss, integrate, and apply both hard and soft skills as students create web pages 

and websites.

Hands-On Practice Web development is a skill and skills are best learned by hands-

on practice. This text emphasizes hands-on practice through exercises within the chapters, 

end-of-chapter exercises, and the development of websites through ongoing real-world 

case studies. The variety of exercises provides instructors with a choice of assignments for 

a particular course or semester.

Website Case Studies There are four case studies that continue throughout most 

of the text (starting with Chapter 2). An additional case study starts in Chapter 5. The 

case studies serve to reinforce the skills discussed in each chapter. Instructors can cycle 

assignments from semester to semester or allow students to choose the case study that 

most interests them. Sample solutions to the case studies are available for download from 

the Instructor Resource Center at www.pearson.com.
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Web Research Each chapter offers web research activities that encourage students to 

further study the topics introduced in the chapter.

Focus on Web Design Most chapters offer additional activities that explore the web 

design topics related to the chapter. These activities can be used to reinforce, extend, and 

enhance the course topics.

FAQs In the author’s web development courses, she is frequently asked similar questions 

by students. They are included in this textbook and are marked with the identifying FAQ logo. 

Checkpoints Each chapter contains two or three Checkpoints, which are groups of 

questions to be used by students to self-assess their understanding of the material. A 

 special Checkpoint icon appears with each group of questions. 

Focus on Accessibility Developing accessible websites is more important than 

ever and this textbook is infused with accessibility techniques throughout. The special icon 

shown here makes accessibility information easy to find.

Focus on Ethics Ethics issues related to web development are highlighted through-

out the textbook and are marked with the special ethics icon shown here.

Reference Materials The appendixes in the Web Developer’s Handbook offer refer-

ence materials, including an HTML5 Quick Reference,  Special Entity Characters, Compari-

son of XHTML and HTML5, a CSS Property Reference, a WCAG 2.0 Quick Reference, an 

FTP Tutorial, an introduction to ARIA Landmark Roles, and a Web-Safe Color Palette.

VideoNotes These short step-by-step videos demonstrate how to solve problems from 

design through coding. VideoNotes allow for self-placed instruction with easy navigation 

including the ability to select, play, rewind, fast-forward, and stop within each VideoNote 

exercise. 

Margin icons in your textbook let you know when a VideoNote video is available for a 

particular concept or homework problem.

Supplemental Materials 

Student Resources The student files for the web page exercises, Website Case 

Study assignments, and access to the book’s VideoNotes are available to all readers of 

this textbook at its companion website www.pearson.com/cs-resources. A complimentary 

access code for the companion website is available with a new copy of this textbook. Sub-

scriptions may also be purchased online.

Instructor Resources The following supplements are available to qualified  instructors 

only. Visit the Pearson Instructor Resource Center (www.pearson.com) for information on 

how to access them:

• Solutions to the end-of-chapter exercises

• Solutions for the case study assignments

Focus on
Accessibility

Focus on 
 Ethics
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• Test questions

• PowerPoint® presentations

• Sample syllabi

Author’s Website In addition to the publisher’s companion website for this textbook, 

the author maintains a website at http://www.webdevfoundations.net. This website contains 

additional resources, including review activities and a page for each chapter with exam-

ples, links, and updates. This website is not supported by the publisher.
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The Internet and the Web are parts of our daily lives. How did they 

begin? What networking protocols and programming languages work behind the 

scenes to display a web page? This chapter provides an introduction to some of 

these topics and is a foundation for the information that web developers need to 

know. You’ll be introduced to Hypertext Markup Language (HTML), the language 

used to create web pages.

1

●● Describe the evolution of the Internet and 

the Web

●● Explain the need for web standards

●● Describe universal design

●● Identify benefits of accessible web design

●● Identify reliable resources of information on 

the Web

●● Identify ethical use of the Web

●● Describe the purpose of web browsers and 

web servers

●● Identify networking protocols

●● Define URIs and domain names

●● Describe HTML, XHTML, and HTML5

●● Describe popular trends in the use of the Web

Chapter Objectives  In this chapter, you will learn how to . . . 

Introduction to the 
Internet and World 
Wide Web
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1.1 The Internet and the Web

The Internet

The Internet, the interconnected network of computer networks that spans the globe, 

seems to be everywhere today. It has become part of our lives. You can’t watch television 

or listen to the radio without being urged to visit a website. Even newspapers and maga-

zines have a place on the Internet.

Birth of the Internet

The Internet began as a network to connect computers at research facilities and univer-

sities. Messages in this network would travel to their destination by multiple routes, or 

paths. This configuration allowed the network to function even if parts of it were broken or 

destroyed. In such an event, the message would be rerouted through a functioning por-

tion of the network while traveling to its destination. This network was developed by the 

Advanced Research Projects Agency (ARPA)—and the ARPAnet was born. Four comput-

ers (located at UCLA, Stanford Research Institute, University of California Santa Barbara, 

and the University of Utah) were connected by the end of 1969.

Growth of the Internet

As time went on, other networks, such as the National Science Foundation’s NSFnet, were 

created and connected with the ARPAnet. Use of this interconnected network, or Internet, 

was originally limited to government, research, and educational purposes. The number 

of individuals accessing the Internet continues to grow each year. According to Internet 

World Stats (http://www.internetworldstats.com/emarketing.htm), the percentage of the 

global population that used the Internet was 0.4% in 1995, 5.8% in 2000, 15.7% in 2005, 

28.8% in 2010, 45% in 2015, and 49.6% in 2017. Visit http://www.internetworldstats.com 

to explore more statistics about the usage and growth of the Internet.

The lifting of the restriction on commercial use of the Internet in 1991 set the stage for future 

electronic commerce: Businesses were now welcome on the Internet. However, the Internet 

was still text based and not easy to use. The next set of developments solved this issue.

Birth of the Web

While working at CERN, a research facility in Switzerland, Tim Berners-Lee envisioned a 

means of communication for scientists by which they could easily “hyperlink” to another 

research paper or article and immediately view it. Berners-Lee created the World Wide 

Web to fulfill this need. In 1991, Berners-Lee posted the code for the Web in a newsgroup 

and made it freely available. This version of the World Wide Web used Hypertext Transfer 

Protocol (HTTP) to communicate between the client computer and the web server, used 

Hypertext Markup Language (HTML) to format the documents, and was text based.

The First Graphical Browser

In 1993, Mosaic, the first graphical web browser became available. Marc Andreessen and 

graduate students working at the National Center for Supercomputing Applications (NCSA) 

at the University of Illinois Urbana–Champaign developed Mosaic. Some individuals in this 

VideoNote

Evolution of the Web
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group later created another well-known web browser—Netscape Navigator—which is an 

ancestor of today’s Mozilla Firefox browser.

Convergence of Technologies

By the early 1990s, personal computers with easy-to-use graphical operating systems (such 

as Microsoft’s Windows, IBM’s OS/2, and Apple’s Macintosh OS) were increasingly available 

and affordable. Online service providers such as CompuServe, AOL, and Prodigy offered 

low-cost connections to the Internet. Figure 1.1 depicts this convergence of available com-

puter hardware, easy-to-use operating systems, low-cost Internet connectivity, the HTTP 

protocol and HTML language, and a graphical browser that made information on the Inter-

net much easier to access. The World Wide Web—the graphical user interface to informa-

tion stored on computers running web servers connected to the Internet—had arrived!

Figure 1.1 Convergence of Technologies

Who Runs the Internet?

You may be surprised that there is no single person “in charge” of the global intercon-

nected network of computer networks known as the Internet. Instead, Internet infrastruc-

ture standards are overseen by groups such as the Internet Engineering Task Force (IETF) 

and the Internet Architecture Board (IAB). The IETF is the principal body engaged in the 

development of new Internet protocol standard specifications. It is an open international 

community of network designers, operators, vendors, and researchers concerned with 

the evolution of Internet architecture and the smooth operation of the Internet. The actual 

technical work of the IETF is completed in its working groups. These working groups are 

organized into areas by topic, such as security and routing.
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The IAB is a committee of the IETF and provides guidance and broad direction to the IETF. 

As a function of this purpose, the IAB is responsible for the publication of the Request for Com-

ments (RFC) document series. An RFC is a formal document from the IETF that is drafted by 

a committee and subsequently reviewed by interested parties. RFCs are available for online 

review at http://www.ietf.org/rfc.html. Some RFCs are informational in nature, while others are 

meant to become Internet standards. In the latter case, the final version of the RFC becomes 

a new standard. Future changes to the standard must be made through subsequent RFCs.

The Internet Corporation for Assigned Numbers and Names (ICANN), http://www.icann.org, 

was created in 1998 and is a nonprofit organization. Its main function is to coordinate the 

assignment of Internet domain names, IP address numbers, protocol parameters, and pro-

tocol port numbers. Prior to 1998, the Internet Assigned Numbers Authority (IANA) coordi-

nated these functions. IANA still performs certain functions under the guidance of ICANN 

and maintains a website at http://www.iana.org.

Intranets and Extranets

Recall that the Internet is an interconnected network of computer networks that is globally 

available. When an organization needs the communication capabilities of the Internet, but 

doesn’t want its information to be available to everyone, either an intranet or extranet is 

appropriate.

An intranet is a private network that is contained within an organization or business. Its 

purpose is to share organizational information and resources among coworkers. When an 

intranet connects to the outside Internet, usually a gateway or firewall protects the intranet 

from unauthorized access.

An extranet is a private network that securely shares part of an organization’s information 

or operations with external partners such as suppliers, vendors, and customers. Extranets 

can be used to exchange data, share information exclusively with business partners, and 

collaborate with other organizations. Privacy and security are important issues in extranet 

use. Digital certificates, encryption of messages, and virtual private networks (VPNs) are 

some technologies used to provide privacy and security for an extranet. Digital certificates 

and encryption used in e-commerce are discussed in Chapter 12.

1.2 Web Standards and Accessibility
Just as with the Internet, no single person or group runs the World Wide Web. However, 

the World Wide Web Consortium (http://www.w3.org), referred to as the W3C, takes a pro-

active role in developing recommendations and prototype technologies related to the Web. 

Topics that the W3C addresses include web architecture, standards for web design, and 

accessibility. In an effort to standardize web technologies, the W3C produces specifications 

called recommendations.

W3C Recommendations

The W3C Recommendations are created in working groups with input from many major cor-

porations involved in building web technologies. These recommendations are not rules; they 

are guidelines. Major software companies that build web browsers, such as Microsoft, do not 

always follow the W3C Recommendations. This makes life challenging for web developers 

because not all browsers will display a web page in exactly the same way. The good news 

is that there is a convergence toward the W3C Recommendations in new versions of major 
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browsers. You’ll follow W3C Recommendations as you code web pages in this book.  Following 

the W3C Recommendations is the first step toward creating a website that is accessible.

Web Standards and Accessibility

The Web Accessibility Initiative (WAI) (http://www.w3.org/WAI), is a major area of work by 

the W3C. Since the Web has become an integral part of daily life, there is a need for all 

individuals to be able to access it.

The Web can present barriers to individuals with visual, auditory, physical, and neuro-

logical disabilities. An accessible website provides accommodations that help individu-

als overcome these barriers. The WAI has developed recommendations for web content 

developers, web authoring tool developers, web browser developers, and developers of 

other user agents to facilitate use of the Web by those with special needs. See the WAI’s 

Web Content Accessibility Guidelines (WCAG) at http://www.w3.org/WAI/WCAG20/glance/

WCAG2-at-a-Glance.pdf for a quick overview.

The WAI continues its work toward an accessible Web. In 2017 the WAI released a draft 

of WCAG 2.1 which is intended to extend WCAG 2.0 and introduce additional success 

 criteria. The new criteria include  requirements for increased support of mobile device 

accessibility, low vision accessibility, and cognitive and learning disability accessibility.

Accessibility and the Law

The Americans with Disabilities Act (ADA) of 1990 is a federal civil rights law that prohibits 

discrimination against people with disabilities. The ADA requires that business, federal, 

and state services are accessible to individuals with disabilities.

Section 508 of the Federal Rehabilitation Act was amended in 1998 to require that U.S. 

government agencies give individuals with disabilities access to information technology 

that is comparable to the access available to others. This law requires developers creating 

information technology (including web pages) for use by the federal government to provide 

for accessibility. The Federal IT Accessibility Initiative (http://www.section508.gov) provides 

accessibility requirement resources for information technology developers. As the Web and 

Internet technologies developed, it became necessary to review the original Section 508 

requirements. New Section 508 requirements, commonly referred to as the Section 508 

Refresh, were aligned to WCAG 2.0 guidelines and published in 

2017. This textbook focuses on WCAG 2.0 guidelines to provide 

accessibility.

In recent years, state governments have also begun to encourage 

and promote web accessibility. The Illinois Information Technology 

Accessibility Act (IITAA) guidelines (see http://www.dhs.state.il.us/

IITAA/IITAAWebImplementationGuidelines.html) are an example of 

this trend.

Universal Design for the Web

Universal design is a “strategy for making products, environments, 

operational systems, and services welcoming and usable to the most 

diverse range of people possible” (https://www.dol.gov/odep/topics/

UniversalDesign.htm). Examples of universal design are all around 

us. The cutouts on curbs that make it possible for people in wheel-

chairs to access the street also benefit a person pushing a stroller 

or riding a Segway Personal Transporter (Figure 1.2). Doors that 
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Figure 1.2 A smooth ride is a benefit of 
universal design
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open automatically for people with mobility challenges also benefit people carrying pack-

ages. A ramp is useful for a person in a wheelchair, a person dragging a rolling backpack 

or carry-on bag, and so on.

Awareness of universal design by web developers has been steadily increasing. Forward-

thinking web developers design with accessibility in mind because it is the right thing to 

do. Providing access for visitors with visual, auditory, and other challenges should be an 

integral part of web design rather than an afterthought.

A person with visual difficulties may not be able to use graphical navigation buttons and may 

use a screen reader device to provide an audible description of the web page. By making a 

few simple changes, such as providing text descriptions for the images and perhaps providing 

a text navigation area at the bottom of the page, web developers can make the page accessi-

ble. Often, providing for accessibility increases the usability of the website for all visitors.

Accessible websites, with alternative text for images, headings used in an organized man-

ner, and captions or transcriptions for multimedia features, are more easily used not only 

by visitors with disabilities, but also by visitors using a browser on a mobile device such as 

a phone or tablet. Finally, accessible websites may be more thoroughly indexed by search 

engines, which can be helpful in bringing new visitors to a site. As this text introduces web 

development and design techniques, corresponding web accessibility and usability issues are 

discussed.

1.3 Information on the Web
These days anyone can publish just about anything on the Web. In this section we’ll 

explore how you can tell if the information you’ve found is reliable and how you can use 

that information.

Reliability and Information on the Web

There are many websites—but which ones are reliable sources of information? When 

visiting websites to find information, it is important not to take everything at face value 

(Figure 1.3).

Questions to ask about web resources are listed as follows:

•	 Is the organization credible? 

Anyone can post anything on the Web! Choose your information 

sources wisely. First, evaluate the credibility of the website itself. 

Does it have its own domain name, such as http://mywebsite.com, 

or is it a free website consisting of just a folder of files hosted on a 

free web hosting site (such as weebly.com, awardspace.com, or 

000webhost.com)? The URL of a free website usually includes part 

of the free web host's domain name. Information obtained from a 

website that has its own domain name will usually (but not always) 

be more reliable than information obtained from a free website.

Evaluate the type of domain name: Is it for a nonprofit organization 

(.org), a business (.com or .biz), or an educational institution (.edu)? 

Businesses may provide information in a biased manner, so be 

careful. Nonprofit organizations and schools will sometimes treat a 

subject more objectively.
Figure 1.3 Who really updated that web 
page you are viewing?
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•	 How recent is the information? 

Another item to look at is the date the web page was created or last updated. 

Although some information is timeless, very often a web page that has not 

been updated for several years is outdated and may not be the best source of 

information.

•	 Are there links to additional resources? 

Hyperlinks indicate websites with supporting or additional information that can be 

helpful to you in your research as you explore a topic. Look for these types of hyper-

links to aid your studies.

•	 Is it Wikipedia? 

Wikipedia (http://wikipedia.org) is a good place to begin research, but don’t accept 

what you read there for fact, and avoid using Wikipedia as a resource for academic 

assignments. Why? Well, except for a few protected topics, anyone can update 

Wikipedia with anything! Usually it all gets sorted out eventually—but be aware that 

the information you read may not be valid.

Feel free to use Wikipedia to begin exploring a topic, but then scroll down to the 

bottom of the Wikipedia web page and look for “References”—and then explore 

those websites and others that you may find. As you gather information on these 

sites, also consider the other criteria: credibility, domain name, timeliness, and links 

to additional resources.

Ethical Use of Information on the Web

This wonderful technology called the World Wide Web provides us with information, graph-

ics, and music—all virtually free (after you pay your Internet service provider, of course). 

Let’s consider the following issues relating to the ethical use of this information:

•	 Is it acceptable to copy someone’s graphic to use on your own website?

•	 Is it acceptable to copy someone’s website design to use on your own site or on a 

client’s site?

•	 Is it acceptable to copy an essay that appears on a web page and use it, or parts of 

it, as your own writing?

•	 Is it acceptable to insult someone on your website or link to that person’s site in a 

derogatory manner?

The answer to all of these questions is no. Using someone’s graphic without permission is 

the same as stealing it. In fact, if you link to it, you are actually using up some of the site’s 

bandwidth and may be costing the owner money. Instead, ask the owner of the website 

for permission to use the graphic. If permission is granted, store the graphic on your own 

website and be sure to indicate the source of the graphic when you display it on your web 

page. The key is to request permission before using someone else’s resources. Copy-

ing the website design of another person or company is also a form of stealing. Any text 

or graphic on a website is automatically copyrighted in the United States, regardless of 

whether a copyright symbol appears on the site or not. Insulting a person or company on 

your website or linking to the person’s or company’s website in a derogatory manner could 

be considered a form of defamation.

Issues like these, related to intellectual property, copyright, and freedom of speech, are 

regularly discussed and decided in courts of law. Good Web etiquette requires that you ask 

permission before using others’ work, give credit for what you use (“fair use” in the U.S. 

Focus on 
 Ethics
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copyright law), and exercise your freedom of speech in a manner that is not harmful to 

others. The World Intellectual Property Organization (WIPO), http://wipo.int, is dedicated to 

protecting intellectual property rights internationally.

What if you’d like to retain ownership, but make it easy for others to use or adapt your 

work? Creative Commons, http://creativecommons.org, is a nonprofit organization that pro-

vides free services that allow authors and artists to register a type of a copyright license 

called a Creative Commons license. There are several licenses to choose from, depending 

on the rights you wish to grant. The Creative Commons license informs others as to exactly 

what they can and cannot do with your creative work. See http://meyerweb.com/eric/tools/

color-blend to view a web page licensed under a Creative Commons Attribution-ShareAlike 

1.0 License.

Checkpoint 1.1   
1. Describe the difference between the Internet and the Web.

2. Explain three events that contributed to the commercialization and exponential 

growth of the Internet.

3. Is the concept of universal design important to web developers? Explain your 

answer.

Figure 1.4  
Common 
components of 
a network

1.4 Network Overview
A network consists of two or more computers connected for the purpose of communicating 

and sharing resources. Common components of a network are shown in Figure 1.4 and 

include the following:

•	 Server computer(s)

•	 Client workstation computer(s)

•	 Shared devices such as printers

•	 Networking devices (routers, hubs, and switches) and the media that connect them
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The clients are the computer workstations used by individuals, such as a personal com-

puter (PC) on a desk. The server receives requests from client computers for resources 

such as files. Computers used as servers are usually kept in a protected, secure area 

and are accessed only by network administrators. Networking devices, such as hubs and 

switches, provide network connections for computers, and routers direct information from 

one network to another. The media connecting the clients, servers, peripherals, and net-

working devices may consist of copper cables, fiber optic cables, or wireless technologies.

Networks vary in scale. A local area network (LAN) is usually confined to a single building 

or group of connected buildings. Your school computer lab may use a LAN. If you work in 

an office, you probably use a computer connected to a LAN. A wide area network (WAN) 

is geographically dispersed and usually uses some form of public or commercial com-

munications network. For example, an organization with offices on both the East and West 

coasts of the United States probably uses a WAN to provide a link between the LANs at 

each of the offices.

A backbone is a high-capacity communication link that carries data gathered from smaller 

links that interconnect with it. On the Internet, a backbone is a set of paths that local or 

regional networks connect to for long-distance interconnection. The Internet is a group 

of interconnected networks with very high-speed connectivity provided by the Internet 

backbones.

1.5 The Client/Server Model
The term client/server dates from the 1980s and refers to personal computers joined by 

a network. “Client/server” can also describe a relationship between two computer pro-

grams—the client and the server. The client requests some type of service (such as a 

file or database access) from the server. The server fulfills the request and transmits the 

results to the client over a network. While both the client and the server programs can 

reside on the same computer, typically they run on different computers (Figure 1.5). It is 

common for a server to handle requests from multiple clients.

The Internet is a great example of client/server architecture at work. Consider the following 

scenario: An individual is at a computer using a web browser client to access the Internet. 

The individual uses the web browser to visit a website, let’s say http://www.yahoo.com. The 

server is the web server program running on the computer with an IP address that cor-

responds to yahoo.com. It is contacted, locates the web page and related resources that 

were requested, and responds by sending them to the individual.

Figure 1.5 Web 
client and web 
server
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Here’s how to distinguish between web clients and web servers:

Web Client

•	 Connected to the Internet when needed

•	 Usually runs web browser (client) software such as Microsoft Edge or Firefox

•	 Uses HTTP

•	 Requests web pages from a server

•	 Receives web pages and files from a server

Web Server

•	 Continually connected to the Internet

•	 Runs web server software (such as Apache or Internet Information Server)

•	 Uses HTTP

•	 Receives a request for the web page

•	 Responds to the request and transmits the status code, web page, and associated 

files

When clients and servers exchange files, they often need to indicate the type of file that is 

being transferred; this is done through the use of a MIME type. Multipurpose Internet Mail 

Extensions (MIME) are rules that allow multimedia documents to be exchanged among 

many different computer systems. MIME was initially intended to extend the original Inter-

net e-mail protocol, but it is also used by HTTP. MIME provides for the exchange of seven 

different media types on the Internet: audio, video, image, application, message, multipart, 

and text. MIME also uses subtypes to further describe the data. The MIME type of a web 

page is text/html. MIME types of GIF and JPEG images are image/gif and image/jpeg, 

respectively.

A web server determines the MIME type of a file before the file is transmitted to the web 

browser. The MIME type is sent along with the document. The web browser uses the MIME 

type to determine how to display the document.

How does information get transferred from the web server to the web browser? Clients 

(such as web browsers) and servers (such as a web server) exchange information through 

the use of communication protocols such as HTTP, TCP, and IP, which are introduced in 

the next section.

1.6 Internet Protocols
Protocols are rules that describe how clients and servers communicate with each other 

over a network. There is no single protocol that makes the Internet and Web work; a num-

ber of protocols with specific functions are needed.

File Transfer Protocol (FTP)

File Transfer Protocol (FTP) is a set of rules that allow files to be exchanged between com-

puters on the Internet. Unlike HTTP, which is used by web browsers to request web pages 

and their associated files in order to display a web page, FTP is used simply to move files 
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from one computer to another. Web developers commonly use FTP to transfer web page 

files from their computers to web servers. FTP is also commonly used to download pro-

grams and files from other servers to individual computers.

E-mail Protocols

Most of us take e-mail for granted, but there are two servers involved in its smooth func-

tioning: an incoming mail server and an outgoing mail server. When you send e-mail to 

others, Simple Mail Transfer Protocol (SMTP) is used. When you receive e-mail, Post Office 

Protocol (POP; currently POP3) and Internet Message Access Protocol (IMAP) can be used.

Hypertext Transfer Protocol (HTTP)

HTTP is a set of rules for exchanging files such as text, images, audio, video, and other 

multimedia on the Web. Web browsers and web servers usually use this protocol. When 

the user of a web browser requests a file by typing a website address or clicking on a 

hyperlink, the browser builds an HTTP request and sends it to the server. The web server 

in the destination machine receives the request, does any necessary processing, and 

responds with the requested file and any associated files (such as image files, media files, 

and other related files).

Transmission Control Protocol/Internet Protocol (TCP/IP)

Transmission Control Protocol/Internet Protocol (TCP/IP) has been adopted as the official 

communication protocol of the Internet. TCP and IP have different functions that work 

together to ensure reliable communication over the Internet.

TCP 

The purpose of TCP is to ensure the integrity of network communication. TCP starts by 

breaking files and messages into individual units called packets. These packets (see 

Figure 1.6) contain information such as the destination, source, sequence number, and 

checksum values used to verify the integrity of the data.

Figure 1.6 TCP 
packet

TCP is used together with IP to transmit files efficiently over the Internet. IP takes over after 

TCP creates the packets, using IP addressing to send each packet over the Internet via the 

best path at the particular time. When the destination address is reached, TCP verifies the 

integrity of each packet by using the checksum, requests a resend if a packet is damaged, 

and reassembles the file or message from the multiple packets.
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IP 

Working in harmony with TCP, IP is a set of rules that controls how data is sent between 

computers on the Internet. IP routes a packet to the correct destination address. Once 

sent, the packet gets successively forwarded to the next closest router (a hardware device 

designed to move network traffic) until it reaches its destination.

Each device connected to the Internet has a unique numeric IP address. These addresses 

consist of a set of four groups of numbers, called octets. The current version of IP, Internet 

Protocol Version 4 (IPv4), uses 32-bit (binary digit) addressing. This results in a decimal 

number in the format of xxx.xxx.xxx.xxx, where each xxx is a value from 0 to 255. Theoreti-

cally, this system allows for at most 4 billion possible IP addresses (although many poten-

tial addresses are reserved for special uses). However, even this many addresses will not 

be enough to meet the needs of all of the devices expected to be connected to the Internet 

in upcoming years.

IP Version 6 (IPv6) will be the next standard IP protocol and will provide a huge increase in 

the number of possible addresses and many technological advances. IPv6 was designed 

as an evolutionary set of improvements to the current IPv4 and is backwardly compatible 

with it. Service providers and Internet users can update to IPv6 independently without hav-

ing to coordinate with each other. IPv6 provides for more Internet addresses because the 

IP address is lengthened from 32 bits to 128 bits. This means that there are potentially 

2128 unique IP addresses possible, or 340,282,366,920,938,463,463,347,607,431,768,

211,456 addresses. (Now there will be enough IP addresses for everyone’s PC, notebook, 

cell phone, tablet, toaster, and so on!)

The IP address of a device may correspond to a domain name. The Domain Name System (DNS) 

associates these IP addresses with the text-based URLs and domain names you type into 

a web browser address box. For example, at the time this book was written, an IP address 

for Google was 216.58.194.46. You can enter this number in the address text box in a 

web browser (as shown in Figure 1.7), press Enter, and the Google home page will display. 

Of course, it’s much easier to type “google.com,” which is why domain names such as 

google.com were created in the first place! Since long strings of numbers are difficult for 

humans to remember, the Domain Name System was introduced as a way to associate 

text-based names with numeric IP addresses.

Figure 1.7 Entering an IP address in a web browser
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1.7  Uniform Resource Identifiers 
and Domain Names

URIs and URLs

A Uniform Resource Identifier (URI) identifies a resource on the Internet. A Uniform 

Resource Locator (URL) is a type of URI which represents the network location of a 

resource such as a web page, a graphic file, or an MP3 file. The URL consists of the proto-

col, the domain name, and the hierarchical location of the file on the web server.

The URL http://www.webdevfoundations.net, shown in Figure 1.8, denotes the 

use of HTTP protocol and the web server named www at the domain name of 

 webdevfoundations.net. In this case, the root file (usually index.html or index.htm) in the 

directory named chapter1 will be displayed.

FAQ What is HTTP/2?

HTTP/2 will be the first major update to HTTP, which was first developed in 1999. 

As websites have become more image and media intensive, the number of requests 

needed to display a web page and its related files have increased. A major benefit of 

HTTP/2 will be quicker loading of web pages by processing multiple concurrent HTTP 

requests. For more information about HTTP/2, visit https://http2.github.io.

Figure 1.8 URL 
Describing a file 
within a folder

Domain Names

A domain name locates an organization or other entity on the Internet. The purpose of the 

Domain Name System (DNS) is to divide the Internet into logical groups and understand-

able names by identifying the exact address and type of the organization. The DNS asso-

ciates the text-based domain names with the unique numeric IP address assigned to a 

device.

Let’s consider the domain name www.google.com. The portion “google.com” is the domain 

name that is registered to Google. The “.com” is the top-level domain name. The “google” 

is considered a second-level domain name. The “www” is the name of the web sever 

(sometimes called the host) at the google.com domain.
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A subdomain can be configured to house a separate website located at the same domain. 

For example, Google’s Gmail can be accessed by using the subdomain “gmail” in the 

domain name (gmail.google.com). Google Maps can be accessed at maps.google.com, 

and Google News Search is available at news.google.com. See http://www.labnol.org/

internet/popular-google-subdomains/5888/ for a list of the top 40 Google subdomains. The 

combination of a host/subdomain, second-level domain, and top-level domain name (such 

as www.google.com or mail.google.com) is called a fully qualified domain name (FQDN).

Top-Level Domain Names  

A top-level domain (TLD) identifies the rightmost part of the domain name, starting with the 

final period. A TLD is either a generic top-level domain (gTLD), such as .com for commercial, 

or a country-code top-level domain, such as .fr for France. The Internet Assigned Numbers 

Authority (IANA) website has a complete list of TLDs (http://www.iana.org/domains/root/db).

Generic Top-Level Domain Names (gTLDs) 

The Internet Corporation for Assigned Names and Numbers (ICANN) administers gTLDs 

(http://www.icann.org). Table 1.1 shows several common gTLDs and their intended use.

Generic TLD Used By

.aero Air-transport industry

.asia Pan-Asia and Asia Pacific community

.biz Businesses

.cat Catalan linguistic and cultural community

.com Commercial entities

.coop Cooperative

.edu Restricted to accredited degree-granting institutions of higher education

.gov Restricted to government use

.info Unrestricted use

.int International organization (rarely used)

.jobs Human resources management community

.mil Restricted to military use

.mobi Corresponds to a .com website—the .mobi site is designed for easy access by 

mobile devices

.museum Museums

.name Individuals

.net Entities associated with network support of the Internet, usually Internet service 

providers or telecommunication companies

.org Nonprofit entities

.post Universal Postal Union, an agency of the United Nations

.pro Professionals such as accountants, physicians, and lawyers

.tel Contact information for individuals and businesses

.travel Travel industry

Table 1.1 Top-level domains

The .com, .org, and .net TLD designations are currently used on the honor system, which 

means that, for example an individual who owns a shoe store (not related to networking) 

can register shoes.net.
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The IANA website at http://www.iana.org/domains/root/db has a complete list of 

 country-code TLDs. Domain names with country codes are often used for municipalities, 

schools, and community colleges in the United States. For example, the domain name 

www.harper.cc.il.us denotes, from right to left, the United States, Illinois, community col-

lege, Harper, and the web server named “www” as the site for Harper College in Illinois.

Although country-code TLD names were intended to designate geographical location, 

it is fairly easy to obtain a domain name with a country-code TLD that is not local to the 

 registrant. Examples of non-geographical use of country-code TLDs include domain 

names such as mediaqueri.es, webteacher.ws, and bit.ly. Visit http://register.com,  

http://godaddy.com, and many other domain name registration companies for examples 

of readily  available country-code TLDs.

Domain Name System (DNS) 

The DNS associates domain names with IP addresses. The following happens each time a 

new URL is typed into a web browser:

1. The DNS is accessed.

2. The corresponding IP address is obtained and returned to the web browser.

Country Code 

TLD Country

.au Australia

.de Germany

.es Spain

.eu European Union (a group of countries rather than a single country)

.in India

.jp Japan

.ly Libya

.nl The Netherlands

.us United States

.ws Samoa

Table 1.2 Country codes

Expect the number and variety of gTLDs to increase. As of 2017 there were over 

1,500 TLDs. The new gTLDs include place names (.quebec, .vegas, and .moscow), 

retail terms (.blackfriday), financial terms (.cash, .trade, and .loans), technology terms 

(. systems, .technology, and .app), and whimsical, fun terms (.ninja, .buzz, and .cool). 

ICANN has set a schedule to periodically launch new gTLDs. Visit http://newgtlds.icann 

.org/en/program-status/delegated-strings for a list of the newest gTLDs.

Country-Code Top-Level Domain Names 

Two-character country codes have also been assigned as TLD names. These codes were 

originally intended to be meaningful by designating the geographical location of the indi-

vidual or organization that registered the name. Table 1.2 lists some popular country codes 

used on the Web.
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3. The web browser sends an HTTP request to the destination computer with the 

c orresponding IP address.

4. The HTTP request is received by the web server.

5. The necessary files are located and sent by HTTP responses to the web browser.

6. The web browser renders and displays the web page and associated files.

We all get impatient sometimes when we need to view a web page. The next time you 

wonder why it is taking so long to display a web page, think about all of the processing 

that goes on behind the scenes before the browser receives the files needed to display the 

web page (Figure 1.9).

Figure 1.9  
Accessing a 
web page

1.8 Markup Languages
Markup languages consist of sets of directions that tell the browser software (and other 

user agents such as mobile phones) how to display and manage a web document. These 

directions are usually called tags and perform functions such as displaying graphics, for-

matting text, and referencing hyperlinks.

Standard Generalized Markup Language (SGML)

SGML is a standard for specifying a markup language or tag set. SGML in itself is not a docu-

ment language, but a description of how to specify one and create a document type defini-

tion (DTD). When Tim Berners-Lee created HTML, he used SGML to create the specification.

Hypertext Markup Language (HTML)

HTML is the set of markup symbols or codes placed in a file intended for display on a web 

browser. The web browser renders the code in the HTML file and displays the web page 

document and associated files. The W3C (http://www.w3.org) sets the standards for HTML.

Extensible Markup Language (XML)

XML was developed by the W3C as a flexible method to create common information 

formats and share the format and the information on the Web. It is a text-based syntax 

designed to describe, deliver, and exchange structured information. It is not intended 
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to replace HTML, but to extend the power of HTML by separating data from presen-

tation. Using XML, developers can create whatever tags they need to describe their 

information.

Extensible Hypertext Markup Language (XHTML)

XHTML uses the tags and attributes of HTML4 along with the more rigorous syntax of XML. 

XHTML was used on the Web for over a decade and you’ll find many web pages coded 

with this markup language. At one point the W3C was working on a new version of XHTML, 

called XHTML 2.0. However, the W3C stopped development of XHTML 2.0 because it was 

not backward compatible with HTML4. Instead, the W3C decided to move forward with 

HTML5.

HTML5—the Newest Version of HTML

HTML5 is the successor to HTML4 and replaces XHTML. HTML5 incorporates features of 

both HTML and XHTML, adds new elements, provides new features such as form edits 

and native video, and is intended to be backward compatible. The W3C approved HTML5 

for final Recommendation status in late 2014. The W3C continued its development of 

HTML and added more new elements, attributes, and features in an update to HTML5 

called HTML5.1. HTML5.1 reached final Recommendation status in late 2016 and work 

has already begun on HTML5.2.

Checkpoint 1.2   
1. Describe the components of the client/server model as applied to the Internet.

2. Identify two protocols used on the Internet to convey information that use the 

 Internet, but do not use the Web.

3. Explain the similarities and differences between a URL and a domain name.

1.9 Popular Uses of the Web

E-Commerce

Continued growth is expected for e-commerce, which is the buying and selling of goods 

and services on the Internet. The research firm eMarketer projects that worldwide retail 

e-commerce sales will increase from $23 trillion in 2017 to $27 trillion in 2020  

(https://www.emarketer.com/Article/Worldwide-Retail-Ecommerce-Sales-Will-Reach-

1915-Trillion-This-Year/1014369). A study by PEW Research Center indicates that about 

80% of American adults shop online (http://www.pewinternet.org/2016/12/19/online-

shopping-and-e-commerce). As mobile web access has become more commonplace, 

 e-commerce will be regularly done not only from desktop computers, but also from 

 portable devices—tablets, netbooks, smartphones, and technology we haven’t even 

 imagined yet.
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Mobile Access

Accessing the Web with devices other than the standard desktop, notebook, and netbook 

computers is a growing trend. The PEW Research Center reported in 2017 that 77% of 

Americans own a smartphone and about 50% own a tablet (http://www.pewinternet.org/

fact-sheet/mobile). Web designers must consider how their pages will display and func-

tion not only on personal computers, but also on smartphones, tablets, and other mobile 

devices.

Blogs

The trend of keeping a web log, or blog, has been driven by individuals as a forum for 

 personal expression. A blog is a journal that is available on the Web; it is a frequently 

updated page with a chronological list of ideas and links. Blog topics range from politics to 

technical information to personal diaries. Blogs can focus on one subject or range across 

a diverse group of topics—it’s up to the person, called a blogger, who has created the 

blog and maintains it. Bloggers usually update their blogs daily with easy-to-use software 

designed to allow people with little or no technical background to update and maintain 

a blog. Many blogs are hosted at blog communities such as http://www.wordpress.com. 

Others are hosted at individual websites, such as the blog kept by the web designer Eric 

Meyer at http://meyerweb.com. Businesses have noted the value of blogs as communica-

tion and customer relationship tools. Companies such as Microsoft (http://blogs.msdn.

com) and IBM (https://www.ibm.com/developerworks/ mydeveloperworks/blogs) utilize 

blogs in this manner.

Wikis

A wiki is a website that can be updated immediately at any time by visitors, using a simple 

form on a web page. Some wikis are intended for a small group of people, such as the 

members of an organization. The most powerful wiki is Wikipedia (http://wikipedia.org), 

an online encyclopedia, which can be updated by anyone at any time. Wikis are a form of 

social software in action—visitors sharing their collective knowledge to create a resource 

freely used by all. While there have been isolated incidents of practical jokes, and inac-

curate information has occasionally been posted at Wikipedia, the given information and 

linked resources are a good starting point when exploring a topic.

Social Networking

Blogs and wikis provide web visitors with new methods for interacting with  websites 

and other people—a use referred to as social computing, or social networking. 

A trendy activity these days is participating in a social networking site such as Facebook  

(http://www.facebook.com) or LinkedIn (http://www.linkedin.com). Research firm 

 eMarketer predicts that in 2020, 70% of Internet users will regularly access a social 

network (https://www.emarketer.com/Article/Nearly-One-Third-of-World-Will-Use-Social-

Networks-Regularly-This-Year/1014157). If it seems to you as if most of your friends are 

on Facebook, that may be the case: As of 2017, Facebook had over two billion monthly 

active users (http://newsroom.fb.com/company-info). While LinkedIn was created with pro-

fessional and business  networking in mind, businesses have also found it useful to create 

Facebook sites to  promote their products and services.
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Twitter (http://www.twitter.com) is a social networking site for microblogging, or frequently 

communicating with a brief message (280 characters or less) called a tweet. Twitter users 

(called twitterers) tweet to update a network of friends and followers about their daily activi-

ties and observations. Twitter is not limited to personal use. The business world has also 

discovered the marketing reach that Twitter can provide. Visit https://business.twitter.com/

basics for insights on how to use Twitter to promote your business and communicate with 

customers.

Cloud Computing

Document collaboration sites like Google Drive and Microsoft OneDrive, blogs, wikis, and 

social networking sites are all accessed via the Internet (the “cloud”) and are examples of 

cloud computing. The National Institute of Standards and Technology (NIST) defines cloud 

computing as the on-demand use of software and other computing resources hosted at a 

remote data center (including servers, storage, services, and applications) over the Inter-

net. Expect to see more public and private use of cloud computing in the future.

RSS

Really Simple Syndication, or Rich Site Summary (RSS) is used to create newsfeeds from 

blog postings and other websites. The RSS feeds contain a summary of new items posted to 

the site. The URL to the RSS feed is usually indicated by the letters XML or RSS in white text 

within an orange rectangle. A newsreader is needed to access the information. Some brows-

ers, such as Firefox and Safari, can display RSS feeds. Commercial and shareware news-

reader applications are also available. The newsreader polls the feed URL at intervals and 

displays the new headlines when requested. RSS provides web developers with a method to 

push new content to interested parties and (hopefully) generate return visits to the site.

Podcasts

Podcasts are audio files on the web that take the format of an audio blog, radio show, or 

interview. Podcasts are typically delivered by an RSS feed, but can also be made available 

by providing the link to a recorded MP3 file on a web page. These files can be saved to 

your computer or to an MP3 player (such as an iPod) for later listening.

Web 2.0

Flickr (http://www.flickr.com) and Pinterest (http://pinterest.com) are two social software 

sites that provide information-sharing opportunities. Flickr, a photo-sharing site, calls itself 

the “best way to store, search, sort, and share your photos.” Pinterest describes itself as 

“a place to discover ideas for all your projects and interests, handpicked by people like 

you.” Pinterest users “pin” photos from websites they have found useful or intriguing on 

“boards” that are organized by categories. Users can search for pins, follow other users, 

and follow boards. Pins of interest are displayed. Websites such as Wikipedia, Flickr, 

 Twitter, and Pinterest are examples of what is called Web 2.0. Web 2.0 is the next step in 

the transition of the Web from isolated static websites to a platform that utilizes  technology 

to provide rich interfaces and social networking opportunities. You may also read Tim 

O’Reilly’s informative Web 2.0 essay at http://www.oreilly.com/pub/a/web2/archive/ 

what-is-web-20.html for more information on this developing topic.



20 Chapter 1 Introduction to the Internet and World Wide Web

The single trend that you can expect to remain the same for the foreseeable future is the 

trend of constant change. Internet and web-related technologies are in a constant state of 

development and improvement. If constant change and the opportunity to learn something 

new excite you, web development is a fascinating field. The skills and knowledge you gain 

in this book should provide a solid foundation for your future learning.

FAQ What is the next big thing on the Web? 

The Web is changing by the minute. Check the textbook’s companion website at  

http://www.webdevfoundations.net for a blog that will help you stay current about  

web trends.
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Chapter Summary
This chapter has provided a brief overview of Internet, Web, and introductory networking 

concepts. Much of this information may already be familiar to you.

Visit the textbook’s website at http://www.webdevfoundations.net for links to the URLs 

listed in this chapter and to view updated information.

Key Terms 
Accessible

Americans with Disabilities Act 

(ADA)

backbone

blog

client/server

clients

cloud computing

country-code top-level domain

Creative Commons

domain name

Domain Name System (DNS)

e-commerce

extranet

Federal IT Accessibility Initiative

File Transfer Protocol (FTP)

fully qualified domain name 

(FQDN)

generic top-level domain  

(gTLD)

hashtag

host

HTML5

Hypertext Markup Language (HTML)

Hypertext Transfer Protocol (HTTP)

Internet

Internet Architecture Board (IAB)

Internet Assigned Numbers 

Authority (IANA)

Internet Corporation for Assigned 

Numbers and Names (ICANN)

Internet Engineering Task Force 

(IETF)

Internet Message Access Protocol 

(IMAP)

intranet

IP

IP address

IP Version 4 (IPv4)

IP Version 6 (IPv6)

local area network (LAN)

markup languages

media

microblogging

Multipurpose Internet Mail 

Extensions (MIME)

network

newsreader

packets

podcasts

Post Office Protocol (POP3)

protocols

Really Simple Syndication or Rich 

Site Summary (RSS)

Request for Comments (RFC)

Section 508 of the Federal 

Rehabilitation Act

server

Simple Mail Transfer Protocol (SMTP)

social computing

social networking

Standard Generalized Markup 

Language (SGML)

subdomain

tablet

TCP

Tim Berners-Lee

top-level domain (TLD)

Transmission Control Protocol/ 

Internet Protocol (TCP/IP)

tweet

Uniform Resource Indicator (URI)

Uniform Resource Locator (URL)

universal design

Web 2.0

Web Accessibility Initiative (WAI)

Web Content Accessibility 

Guidelines (WCAG)

web host server

wide area network (WAN)

wiki

World Intellectual Property 

Organization (WIPO)

World Wide Web

World Wide Web Consortium (W3C)

XHTML

XML

Review Questions 

Multiple Choice

1. What is a unique text-based Internet address 

 corresponding to a computer’s unique numeric IP 

address called?

a. IP address

b. domain name

c. URL

d. user name

2. Select the item below that indicates the top-level 

domain name for the URL  

http://www.mozilla.com.

a. mozilla

b. com

c. http

d. www
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Hands-On Exercise
1. Twitter (http://www.twitter.com) is a social networking website for microblogging, or 

frequently communicating with a brief message (280 characters of less) called a 

tweet. Twitter users (referred to as twitterers) tweet to update a network of friends and 

followers about their daily activities, observations, and information related to topics 

of interest. A hashtag (the #symbol) can be placed in front of a word or term within a 

tweet to categorize the topic, such as typing the hashtag #SXSWi in all tweets about 

the SXSW Interactive Conference for the web design industry. The use of a hashtag 

makes it easy to search for tweets about a category or event in Twitter.

If you don’t already use Twitter, sign up for free account at http://www.twitter.com. Use 

your Twitter account to share information about websites that you find useful or inter-

esting. Post at least three tweets. You might tweet about websites that contain useful 

web design resources. You might describe sites that have interesting features, such 

3. Of the following organizations, which one coordi-

nates applications for new TLDs?

a. Internet Assigned Numbers Authority (IANA)

b. Internet Engineering Task Force (IETF)

c. Internet Corporation for Assigned Numbers and 

Names (ICANN)

d. World Wide Web Consortium (W3C)

4. Which of the following is a network that cov-

ers a small area, such as a group of buildings or 

campus?

a. LAN

b. WAN

c. Internet

d. WWW

5. Which of the following organizations takes a pro-

active role in developing recommendations and 

prototype technologies related to the Web?

a. World Wide Web Consortium (W3C)

b. Web Professional Standards Organization (WPO)

c. Internet Engineering Task Force (IETF)

d. Internet Corporation for Assigned Numbers and 

Names (ICANN)

True or False

6. ____________ A URL is one type of URI.

7. ____________ Markup languages contain sets of 

directions that tell the browser software how to 

display and manage a web document.

8. ____________ The World Wide Web was devel-

oped to allow companies to conduct e-commerce 

over the Internet.

9. ____________ A domain name that ends in .net 

indicates that the website must be for a network-

ing company.

10. ____________ An accessible website provides 

accommodations that help individuals overcome 

barriers such as visual, auditory, physical, and 

neurological disabilities.

Fill in the Blank

11. ____________ is the set of markup symbols or 

codes placed in a file intended for display on a 

web browser.

12. A ____________ can be configured to house a 

separate website located at the same domain.

13. A standard language used for specifying a 

markup language or tag set is ____________.

14. Frequently communicating by posting brief 

messages at a social networking site is called 

____________.

15. The purpose of ____________ is to ensure the 

integrity of network communication.
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as compelling graphics or easy-to-use navigation. After you begin to develop your own 

websites, you could tweet about them, too!

Your instructor may direct you to include a distinctive hashtag (for example, something 

like #CIS110) in your tweets that are related to your web design studies. Searching 

Twitter for the specified hashtag will make it easy to collect all the tweets posted by the 

students in your class.

2. Create a blog to document your learning experiences as you study web develop-

ment. Visit one of the many sites that offer free blogs, such as http://www.blogger.com, 

http://www.wordpress.com, or http://www.tumblr.com. Follow the site’s instructions 

to establish your own blog. Your blog could be a place to note websites that you 

find useful or interesting. You might report on sites that contain useful web design 

resources. You might describe sites that have interesting features, such as compel-

ling graphics or easy-to-use navigation. Write a few sentences about each site that 

you find intriguing. After you begin to develop your own sites, you could include the 

URLs and reasons for your design decisions. Share this blog with your fellow students 

and friends. Display your page in a browser, and print the page. Hand in the printout 

to your instructor.

Web Research
1. The World Wide Web Consortium creates standards for the Web. Visit its site at  

http://www.w3c.org and then answer the following questions:

a. How did the W3C get started?

b. Who can join the W3C? What does it cost to join?

c. The W3C home page lists a number of technologies. Choose one that interests 

you, click on its link, and read the associated pages. List three facts or issues you 

discover.

2. The Internet Society takes an active leadership role in issues related to the Internet. 

Visit its site at http://www.isoc.org and then answer the following questions:

a. Why was the Internet Society created?

b. Determine which local chapter is closest to you. Visit its website. List the website’s 

URL and an activity or service that the chapter provides.

c. How can you join the Internet Society? What does it cost to join? Would you recom-

mend that a beginning Web developer join the Internet Society? Why or why not?

3. HTTP/2 is the first major update to HTTP, which was first developed in the late 1990s. 

As websites have become more image and media intensive, the number of requests 

needed to display a web page and its related files have increased. A major benefit of 

HTTP/2 will be quicker loading of web pages.

HTTP/2 Resources:

•	 http://readwrite.com/2015/02/18/http-update-http2-what-you-need-to-know

•	 https://http2.github.io

•	 http://www.engadget.com/2015/02/24/what-you-need-to-know-about-http-2

•	 https://tools.ietf.org/html/rfc7540
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Use the resources listed above as a starting point as you research HTTP/2 and answer 

the following questions.

a. Who developed HTTP/2?

b. When was the HTTP/2 proposed standard published?

c. Describe three methods used by HTTP/2 intended to decrease latency and provide 

for quicker loading of web pages in browsers.

Focus on Web Design
1. Visit a website that interests you. Print the home page or one other pertinent page 

from the site. Write a one-page summary of the site that addresses the following 

topics:

a. What is the URL of the site?

b. What is the purpose of the site?

c. Who is the intended audience?

d. Do you think that the site reaches its intended audience? Why or why not?

e. Is the site useful to you? Why or why not?

f. Does this site appeal to you? Why or why not? Consider the use of color, images, 

multimedia, organization, and ease of navigation.

g. Would you encourage others to visit this site? Why or why not?

h. How could this site be improved?



This chapter gets you started on your very first web page. You’ll be 

introduced to Hypertext Markup Language (HTML), the language used to  create 

web pages. The chapter begins with an introduction to the syntax of HTML5; 

continues with sample web pages; and introduces HTML structural, phrase, and 

hyperlink elements as more example web pages are created. You will learn more 

if you work along with the sample pages in the text. Coding HTML is a skill, and 

every skill improves with practice.

2

●● Describe HTML, XHTML, and HTML5

●● Identify the markup language in a web page 

document

●● Use the html, head, body, title, and meta 

elements to code a template for a web page

●● Configure the body of a web page with 

headings, paragraphs, line breaks, divs, lists, 

and blockquotes

●● Configure text with phrase elements

●● Configure special characters

●● Use the new HTML5 header, nav, main, and 

footer elements

●● Use the anchor element to link from page to 

page

●● Create absolute, relative, and e-mail 

hyperlinks

●● Code, save, and display a web page 

document

●● Test a web page document for valid syntax

Chapter Objectives  In this chapter, you will learn how to . . . 

HTML Basics
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2.1 HTML Overview
Markup languages consist of sets of directions that tell the browser software (and other 

user agents such as mobile phones) how to display and manage a web document. These 

directions are usually called tags and perform functions such as displaying graphics, for-

matting text, and referencing hyperlinks.

The World Wide Web is composed of files containing Hypertext Markup Language (HTML) 

and other markup languages that describe web pages. Tim Berners-Lee developed 

HTML using Standard Generalized Markup Language (SGML). SGML prescribes a 

 standard  format for embedding descriptive markup within a document and for  describing 

the  structure of a document. SGML is not in itself a document language, but rather a 

 description of how to specify one and create a document type definition (DTD). The W3C 

(http://www. w3c. org) sets the standards for HTML and its related languages. Like the Web 

itself, HTML is in a constant state of change.

HTML

HTML is the set of markup symbols or codes placed in a file that is intended for display 

on a web page. These markup symbols and codes identify structural elements such as 

paragraphs, headings, and lists. HTML can also be used to place media (such as graph-

ics, video, and audio) on a web page and describe fill-in forms. The browser interprets the 

markup code and renders the page. HTML permits the platform-independent display of 

information across a network. No matter what type of computer a web page was created 

on, any browser running on any operating system can display the page.

Each individual markup code is referred to as an element or tag. Each tag has a purpose. 

Tags are enclosed in angle brackets, the < and > symbols. Most tags come in pairs: an 

opening tag and a closing tag. These tags act as containers and are sometimes referred to 

as container tags. For example, the text that is between the <title> and </title> tags 

on a web page would display in the title bar on the browser window. Some tags are used 

alone and are not part of a pair. For example, a <br> tag that configures a line break on 

a web page is a stand-alone, or self-contained, tag and does not have a closing tag. Most 

tags can be modified with attributes that further describe their purpose.

XML

XML (eXtensible Markup Language) was developed by the W3C to create common informa-

tion formats and share the format and the information on the Web. It is a text-based syntax 

designed to describe, deliver, and exchange structured information, such as RSS feeds. XML is 

not intended to replace HTML, but to extend the power of HTML by separating data from pres-

entation. Using XML, developers can create any tags they need to describe their information.

XHTML

eXtensible HyperText Markup Language (XHTML) uses the tags and attributes of HTML4 

along with the syntax of XML. XHTML was used on the Web for over a decade and you’ll 

find many web pages coded with this markup language. At one point the W3C was working 

on a new version of XHTML, called XHTML 2.0. However, the W3C stopped development 

of XHTML 2.0 because it was not backward compatible with HTML4. Instead, the W3C 

decided to move forward with HTML5.
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HTML5

HTML5 is the successor to HTML4 and replaces XHTML. HTML5 incorporates features 

of both HTML and XHTML, adds new elements of its own, provides new features such as 

form edits and native video, and is intended to be backward compatible.

The W3C approved HTML5 for final Recommendation status in late 2014. The W3C 

 continued its development of HTML and added more new elements, attributes, and 

 features in an update to HTML5 called HTML 5.1. In 2017, HTML5.1 reached final 

 Recommendation status and work had already begun on HTML5.2.

Recent versions of popular browsers, such as Microsoft Edge, Firefox, Safari, Google 

Chrome, and Opera, support most features of HTML5 and HTML5.1. You’ll learn to 

use HTML5.1 syntax as you work through this textbook. W3C HTML5 documentation is 

 available at https://www.w3.org/TR/html/.

2.2 Document Type Definition
Because multiple versions and types of HTML and XHTML exist, the W3C recommends 

identifying the type of markup language used in a web page document with a Document 

Type Definition (DTD). The DTD identifies the version of HTML contained in your document. 

Browsers and HTML code validators can use the information in the DTD when processing 

the web page. The DTD statement, commonly called a doctype statement, is the first line of 

a web page document. The DTD for HTML5 is:

<!DOCTYPE html>

FAQ What software do I need?

No special software is needed to create a web page document; all you need is a text 

editor. The Notepad text editor is included with Microsoft Windows. TextEdit is distrib-

uted with the Mac OS X operating system. (See http://support.apple.com/kb/TA20406 

for configuration information.) An alternative to the operating system’s basic text editor 

is one of the many free or shareware editors that are available, such as  Notepad++ 

for  Windows (http://notepad-plus-plus.org/ download) and BBEdit for Macs  

(http://www.barebones.com/products/bbedit/index.html). Another commonly used 

alternative is a commercial web-authoring tool, such as Adobe  Dreamweaver. 

 Regardless of the software or program you use, having a solid foundation in HTML 

will be useful.

You will need to test your web pages in the most popular browsers, such as  Microsoft 

Edge, Mozilla Firefox, Apple Safari, and Google Chrome. Access a free download 

of Firefox at www.mozilla.org/mozilla/firefox. A free download of Google Chrome is 

 available at http://www.google.com/chrome.

You will also find the Web Developer Extension for Firefox (https://addons.mozilla.org/

en-us/firefox/addon/web-developer) to be useful.
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2.3 Web Page Template
You already know that the HTML markup language tells 

 browsers how to display information on a web page. Let’s take 

a closer look at what’s “under the hood” (Figure 2.1) of every 

web page you create. Every single web page you create will 

include the DTD and the html, head, title, meta, and body ele-

ments. We will follow the coding style to use lowercase letters 

and place quotes around attribute values. A basic HTML5 web 

page template (see chapter2/template.html in the student files) 

is as follows:

<!DOCTYPE html>

<html lang="en">

<head>

<title>Page Title Goes Here</title>

<meta charset="utf-8">

</head>

<body>

... body text and more HTML tags go here ... 

</body>

</html>

With the exception of the specific page title, the first seven lines will usually be the 

same on every web page that you create. Review the code above and notice that the 

document type definition statement has its own formatting and that the HTML tags all 

use lowercase letters. Next, let’s explore the purpose of the html, head, title, meta, and 

body elements.

2.4 HTML Element
The purpose of the html element is to indicate that the document is HTML formatted. The 

html element tells the browser how to interpret the document. The opening <html> tag is 

placed on a line below the DTD. The closing </html> tag indicates the end of the web 

page and is placed after all other HTML elements in the document.

The html element also needs to indicate the spoken language, such as English, of the text 

in the document. This additional information is added to the <html> tag in the form of an 

attribute, which modifies or further describes the function of an element. The lang attribute 

specifies the spoken language of the document. For example, lang="en" indicates the 

English language. Search engines and screen readers may access this attribute.

2.5 Head, Title, Meta, and Body Elements
There are two sections on a web page: the head and the body. The head section con-

tains information that describes the web page document. The body section contains 

the actual tags, text, images, and other objects that are displayed by the browser as a 

web page.

Figure 2.1 It’s what is under the hood that 
matters.



2.6 Your First Web Page 29

The Head Section

Elements that are located in the head section include the title of the web page, meta tags 

that describe the document (such as the character encoding used and information that 

may be accessed by search engines), and references to scripts and styles. Many of these 

features do not show directly on the web page.

The head element contains the head section, which begins with the <head> tag and ends 

with the </head> tag. You will always code at least two other elements in the head sec-

tion: a title element and a meta element.

The first element in the head section, the title element, configures the text that will appear in the 

title bar of the browser window. The text between the <title> and </title> tags is called 

the title of the web page and is accessed when web pages are bookmarked and printed. Popular 

search engines, such as Google, use the title text to help determine keyword relevance and even 

display the title text on the results page of a search. A descriptive title that includes the website 

or organization name is a crucial component for establishing a brand or presence on the Web.

The meta element describes a characteristic of a web page, such as the character encod-

ing. Character encoding is the internal representation of letters, numbers, and symbols in 

a file such as a web page or other file that is stored on a computer and may be transmit-

ted over the Internet. There are many different character-encoding sets. However, it is 

common practice to use a character-encoding set that is widely supported, such as utf-8, 

which is a form of Unicode (http://www.unicode.org). The meta tag is not used as a pair 

of opening and closing tags. It is considered to be a stand-alone, or self-contained, tag 

(referred to as a void element in HTML5). The meta tag uses the charset attribute to indi-

cate the character encoding. An example meta tag is as follows:

<meta charset="utf-8">

The Body Section

The body section contains text and elements that display directly on the web page in the 

browser window, also referred to as the browser viewport. The purpose of the body section 

is to configure the contents of the web page.

The body element contains the body section, which begins with the <body> tag and ends 

with the </body> tag. You will spend most of your time writing code in the body of a web 

page. Text and elements typed between the opening and closing body tags will display on 

the web page in the browser viewport.

2.6 Your First Web Page

Hands-On Practice 2.1   

Now that you’re familiar with basic elements used on every web page, it’s your turn to 

create your first web page, shown in Figure 2.2.

VideoNote

Your First  

Web Page

Figure 2.2 Your 
first webpage
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Create a Folder

You’ll find it helpful to create folders to organize your files as you develop the web pages 

in this book and create your own websites. Use your operating system to create a new 

folder named mychapter2 on your hard drive or a portable flash drive.

To create a new folder on a Mac:

1. Launch Finder, and select the location where you would like to create the new folder.

2. Choose File > New Folder to create an untitled folder.

3. To rename the folder, select the folder and click on the current name. Type a name 

for the folder, and press the Return key.

To create a new folder with Windows:

1. Launch File Explorer (formerly called Windows Explorer):

a. Display the Desktop.

b. Right-click on the Start button and select File Explorer.

2. Navigate to the location where you would like to create the new folder, such as 

Documents, your C: drive, or an external USB drive.

3. Select the Home tab. Select New Folder.

4. To rename the New Folder, right-click on it, select Rename from the context- 

sensitive menu, type in the new name, and press the Enter key.

FAQ Why should I create a folder? Why not just use the desktop?

Folders will help you to organize your work. If you just use the desktop, it would 

quickly become cluttered and disorganized. It’s also important to know that web-

sites are organized on web servers within folders. By starting to use folders right 

away to organize related web pages, you are on your way to becoming a suc-

cessful web designer.

Your First Web Page

Now you are ready to create your first HTML5 web page. Launch Notepad or another 

text editor. Type in the following code:

<!DOCTYPE html>

<html lang="en">

<head>

<title>My First HTML5 Web Page</title>

<meta charset="utf-8">

</head>

<body>

Hello World

</body>

</html>
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Notice that the first line in the file contains the doctype. The HTML code begins with an 

opening <html> tag and ends with a closing </html> tag. The purpose of these tags 

is to indicate that the content between them makes up a web page. The head section 

is delimited by <head> and </head> tags and contains a pair of title tags with the 

words “My First HTML5 Web Page” in between, along with a <meta> tag to indicate the 

character encoding.

The body section is delimited 

by <body> and </body> tags. 

The words “Hello World” are 

typed on a line between the body 

tags. See Figure 2.3 for a screen-

shot of the code as it would 

appear in Notepad. You have just 

created the source code for a 

web page document.

FAQ Do I have to start each tag on its own line?

No, you are not required to start each tag on a separate line. A browser can 

display a page even if all the tags follow each other on one line with no spaces. 

Humans, however, find it easier to write and read web page code if line breaks 

and indentation are used.

Figure 2.3 Code displayed in Notepad. Courtesy of 

Microsoft Corporation.

Save Your File

You will save your file with the name of index.html. A common file name for the home 

page of a website is index.html or index.htm. Web pages use either a .htm or a .html file 

extension. The web pages in this book use the .html file extension. Display your file in 

Notepad or another text editor. Select File from the menu bar, and then select Save As. 

The Save As dialog box will appear. Navigate to your mychapter2 folder. Using Figure 

2.4 as an example, type the file name. Click the Save button after you type the file name. 

Sample solutions for the exercises are available in the  student files. If you like, you can 

compare your work with the solution in the student files at  

chapter2/index. html before you test your page.

Figure 2.4 The Save As dialog box. Courtesy of Microsoft 

Corporation.
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FAQ Why does my file have a .txt file extension?

In some older versions of Windows, Notepad will automatically append a .txt 

file extension. If this happens, type the name of the file within quotation marks 

(“index.html”), and save your file again.

Test Your Page

There are two ways to test your page:

1. Launch File Explorer or Finder (Mac). Navigate to your index.html file. 

 Double-click index.html. The default browser will launch and will display your 

index.html page.

2. Launch a web browser. Select File > Open, and navigate to your index.html file. 

Double-click index.html and click OK. The browser will display your index.html 

page.

Examine your page. If you are using Microsoft Edge, your page should look simi-

lar to the one shown in Figure 2.5. A display of the page using Firefox is shown in 

Figure 2.2. Look carefully at the browser window. Notice how the browser title bar 

or browser tab displays the title text, “My First HTML5 Web Page.” Some search 

engines use the text enclosed within the <title> and </title> tags to help 

determine the relevancy of keyword searches, so make certain that your pages 

contain descriptive titles. The title element is also used when viewers bookmark 

your page or add it to their Favorites. An engaging and descriptive page title may 

entice a visitor to revisit your page. If your web page is for a company or an orga-

nization, it’s a best practice to include the name of the company or organization in 

the title.

Figure 2.5 Web page displayed by Microsoft Edge. Courtesy of 

Microsoft Corporation.
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FAQ Why doesn’t the heading tag go in the head section?

It’s common for students to try to code the heading tags in the head section of the 

document, but doing this is not valid and will cause issues with the way the browser 

displays the web page. Even though “heading tag” and “head section” sound similar, 

always code heading tags in the body section of the web page document.

FAQ  When I viewed my page in a browser, the file name was 
index. html.html–why did this happen?

This usually happens when your operating system is configured to hide file exten-

sion names. You will correct the file name, using one of the following two methods:

•	 Use the operating system to rename the file from “index.html.html” to “index.html”.

OR

•	 Open the index.html.html file in your text editor and save it with the name 

“index.html”.

It’s a good idea to change the settings in your operating system to show file ex-

tension names. Access the system help for your operating system or the resourc-

es below for information about how to configure your operating system to show 

file extension names:

•	 Windows: http://www.file-extensions.org/article/show-and-hide-file- 

extensions-in-windows-10

•	 Mac: http://www.fileinfo.com/help/mac_show_extensions

Checkpoint 2.1  
1. Describe the origin, purpose, and features of HTML.

2. Describe the software needed to create and test web pages.

3. Describe the purpose of the head and body sections of a web page.

2.7 Heading Element
Heading elements are organized into six levels: h1 through h6. The text contained within 

a heading element is rendered as a “block” of text by the browser (referred to as block 

display) and displays with empty space (sometimes called “white space”) above and 

below. The size of the text is largest for <h1> (called the heading 1 tag) and smallest for 

<h6> (called the heading 6 tag). Depending on the font being used (more on font sizes 

in  Chapter 3), the text contained within <h4>, <h5>, and <h6> tags may be displayed 

smaller than the default text size. All text contained within heading tags is displayed with 

bold font weight. Figure 2.6 shows a web page document with six levels of headings.
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Hands-On Practice 2.2  

To create the web page shown in Figure 2.6, launch Notepad or another text editor. 

Select File > Open to edit the HTML5 template file located at chapter2/template.html 

in the  student files. Modify the title element and add heading tags to the body section 

as indicated by the  following highlighted code:

<!DOCTYPE html>

<html lang="en">

<head>

<title>Heading Example</title>

<meta charset="utf-8">

</head>

<body>

<h1>Heading Level 1</h1>

<h2>Heading Level 2</h2>

<h3>Heading Level 3</h3>

<h4>Heading Level 4</h4>

<h5>Heading Level 5</h5>

<h6>Heading Level 6</h6>

</body>

</html>

Save the document as heading.html on your hard drive or flash drive. Launch a 

browser such as Microsoft Edge or Firefox to test your page. It should look similar to 

the page shown in Figure 2.6. You can compare your work with the solution found in 

the student files (chapter2/heading.html).

Figure 2.6 Sample  
headings
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Accessibility and Headings

Heading tags can help to make your pages more accessible and usable. It is good coding 

practice to use heading tags to outline the structure of your web page content. To indicate 

areas within a page hierarchically, code heading tags numerically as appropriate (h1, h2, 

h3, and so on), and include page content in block display elements such as paragraphs 

and lists. In Figure 2.7, the <h1> tag contains the name of the website in the logo header 

area at the top of the web page, the <h2> tag contains the topic or name of the page in 

the content area, and other heading elements are coded in the content area as needed to 

identify major topics and subtopics.

Visually challenged visitors who are using a screen reader can direct the software to 

 display a list of the headings used on a page to focus on the topics that interest them. 

Your well-organized page will be more usable for every visitor to your site, including those 

who are visually challenged.

2.8 Paragraph Element
Paragraph elements are used to group sentences and sections of text together. Text that is 

contained by <p> and </p> tags display as a “block” (referred to as block display) and 

will appear with empty space above and below it. Figure 2.8 shows a web page document 

with a paragraph after the first heading.

Focus on
Accessibility

Figure 2.7 Heading tags outline the page

Figure 2.8 Web page using headings and a paragraph
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Hands-On Practice 2.3  

To create the web page shown in Figure 2.8, launch a text editor. Select File > Open to 

edit the file located at chapter2/heading.html in the student files. Modify the page title, 

and add a paragraph of text to your page below the line with the <h1> tags and above 

the line with the <h2> tags. Use the following code as an example:

<!DOCTYPE html>

<html lang="en">

<head>

<title>Paragraph Example</title>

<meta charset="utf-8">

</head>

<body>

<h1>Heading Level 1</h1>

<p>This is a sample paragraph. Heading tags can help to make your 

pages more accessible and usable. It is good coding practice to use 

heading tags to outline the structure of your web page content.

</p> 

<h2>Heading Level 2</h2>

<h3>Heading Level 3</h3>

<h4>Heading Level 4</h4>

<h5>Heading Level 5</h5>

<h6>Heading Level 6</h6>

</body>

</html>

Save the document as paragraph.html on your hard drive or flash drive. Launch a 

browser to test your page. It should look similar to the page shown in Figure 2.8. You 

can compare your work with the solution (chapter2/paragraph.html) found in the  student 

files. Notice how the text in the paragraph wraps automatically as you resize your 

browser window.

Alignment

As you tested your web pages, you may have noticed that the headings and text begin near 

the left margin. This placement is called left alignment and is the default alignment for web 

pages. There are times, however, when you want a paragraph or heading to be centered or 

right aligned. The align attribute can be used for this purpose. The purpose of an attribute 

is to modify the properties of an HTML element. In this case, the align attribute modifies 

the element’s horizontal alignment (left, center, or right) on a web page. To center an ele-

ment on a web page, use the attribute align="center". To right-align the text within an 

element, use the align="right" attribute. In XHTML syntax, the align attribute can be 

used with a number of block display elements, including the paragraph (<p>) and heading 

(<h1> through <h6>) tags. The align attribute is obsolete in HTML5, which means that 

while it may be used in XHTML, the attribute has been removed from the W3C HTML5 

specification and is invalid. In Chapter 6, you will learn how to configure alignment using a 

more modern approach with Cascading Style Sheets (CSS).
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2.9 Line Break Element
The line break element causes the browser to advance to the next line before displaying the 

next element or portion of text on a web page. The line break tag is not coded as a pair of open-

ing and closing tags. It is a stand-alone, or void element, and is coded as <br>.  Figure 2.9 

shows a web page document with a line break after the first sentence in the paragraph.

Figure 2.9  
Notice the line 
break after the 
first sentence

Hands-On Practice 2.4  

To create the web page shown in Figure 2.9, launch a text editor. Select File > Open 

to edit the file located at chapter2/paragraph.html in the student files. Modify the text 

contained between the title tags to be “Line Break Example”. Place your cursor after the 

first sentence in the paragraph (after “This is a sample paragraph.”). Press the Enter key. 

Save your file. Test your page in a browser, and notice that even though your source 

code showed the “This is a sample paragraph.” sentence on its own line, the browser 

did not render it that way. A line break tag is needed to configure the browser to display 

the second sentence on a new line. Edit the file in a text editor, and add a <br> tag after 

the first sentence in the paragraph, as shown in the following code snippet:

<body>

<h1>Heading Level 1</h1>

<p>This is a sample paragraph. <br> Heading tags can help to make your 

pages more accessible and usable. It is good coding practice to use 

heading tags to outline the structure of your web page content.

</p>

<h2>Heading Level 2</h2>

<h3>Heading Level 3</h3>

<h4>Heading Level 4</h4>

<h5>Heading Level 5</h5>

<h6>Heading Level 6</h6>

</body>

Save your file as linebreak.html. Launch a browser to test your page. It should look simi-

lar to the page shown in Figure 2.9. You can compare your work with the solution found 

in the student files (chapter2/linebreak.html).
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FAQ Why does my web page still look the same?

Often, students make changes to a web page document, but get frustrated because 

their browser shows an older version of the page. The following troubleshooting tips 

are helpful when you know you modified your web page, but the changes do not show 

up in the browser:

1. Make sure you save your page after you make the changes.

2. Verify the location that you are saving your page to—a specific folder on the hard 

drive or removable storage.

3. Verify the location that your browser is requesting the page from—a specific folder on 

the hard drive or removable storage.

4. Be sure to click the Refresh or Reload button in your browser.

Hands-On Practice 2.5  

To create the web page shown in Figure 2.10, launch a text editor. Select File > Open 

to edit the template file located at chapter2/template.html in the student files. Modify 

the title element. Add a heading tag, a paragraph tag, and a blockquote tag to the body 

section as indicated by the following highlighted code:

<!DOCTYPE html>

<html lang="en">

<head>

<title>Blockquote Example</title>

<meta charset="utf-8">

</head>

<body>

<h1>The Power of the Web</h1>

<p>According to Tim Berners-Lee, the inventor of the World Wide Web, 

at http://www.w3.org/WAI/:</p>

<blockquote>

The power of the Web is in its universality. Access by everyone 

regardless of disability is an essential aspect.

</blockquote> 

</body>

</html>

2.10 Blockquote Element
In addition to organizing text in paragraphs and headings, 

sometimes you need to add a quotation to a web page. The 

blockquote element is used to display a block of quoted text 

in a special way—indented from both the left and right mar-

gins. A block of indented text begins with a <blockquote> 

tag and ends with a </blockquote> tag. Figure 2.10 shows 

a web page document with a heading, a paragraph, and a 

blockquote.
Figure 2.10 The text within the blockquote 
element is indented
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You have probably noticed how convenient the <blockquote> tag could be if you need to 

indent an area of text on a web page. You may have wondered whether it would be okay to 

use the blockquote element anytime you would like to indent text or whether the blockquote 

element is reserved only for long quotations. The semantically correct use of the blockquote 

element is only for displaying large blocks of quoted text within a web page. Why should 

you be concerned about semantics? Consider the future of the Semantic Web, described in 

Scientific American (http://www.scientificamerican.com/article.cfm?id=the-semantic-web) 

as “A new form of Web content that is meaningful to computers [that] will unleash a revolu-

tion of new possibilities.” Using HTML in a semantic, structural manner is one step toward 

the Semantic Web. So, avoid using a blockquote element just to indent text. You will learn 

modern techniques to configure margins and padding on elements later in this book.

2.11 Phrase Elements
Phrase elements indicate the context and meaning of the text between the container tags. 

It is up to each browser to interpret that style. Phrase elements are displayed right in line 

with the text (referred to as inline display) and can apply to a section of text or even just a 

single character of text. For example, the <strong> element indicates that the text asso-

ciated with it has strong importance and should be displayed in a “strong” manner in rela-

tion to normal text on the page. Table 2.1 lists common phrase elements and examples of 

their use. Notice that some tags, such as <cite> and <dfn>, result in the same type of 

display (italics) as the <em> tag in popular browsers. These tags semantically describe the 

text as a citation or definition, but the physical display is usually italics in both cases.

Save the document as blockquote.html on your hard drive or flash drive. Launch a 

browser to test your page. It should look similar to the page shown in Figure 2.10. 

You can compare your work with the solution (chapter2/blockquote.html) found in the 

 student files.

Element Example Usage

<abbr> WIPO Identifies text as an abbreviation; configure the title attribute with the full name

<b> bold text Text that has no extra importance, but is styled in bold font by usage and convention

<cite> cite text Identifies a citation or reference; usually displayed in italics

<code> code text Identifies program code samples; usually a fixed-space font

<dfn> dfn text Identifies a definition of a word or term; usually displayed in italics

<em> emphasized text Causes text to be emphasized in relation to other text; usually displayed in italics

<i> italicized text Text that has no extra importance, but is styled in italics by usage and convention

<kbd> kbd text Identifies user text to be typed; usually a fixed-space font

<mark>  mark text Text that is highlighted in order to be easily referenced

<samp> samp text Shows program sample output; usually a fixed-space font

<small> small text Legal disclaimers and notices (“fine print”) displayed in small font size

<strong> strong text Strong importance; causes text to stand out from surrounding text; usually displayed in bold

<sub> sub text Displays a subscript as small text below the baseline

<sup> sup text Displays a superscript as small text above the baseline

<var> var text Identifies and displays a variable or program output; usually displayed in italics

Table 2.1 Phrase elements


